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Premessa
Lo scopo di questo documento è di fornire una guida pratica all'uso del programma Geopsy per 
l'elaborazione di prove HVSR e MASW.

Il documento affronta nel dettaglio ogni fase del ciclo di utilizzo del programma:
• Download ed installazione
• Elaborazione HVSR
• Elaborazione MASW
• Inversione dei risultati HVSR/MASW al fine di ottenere il profilo stratigrafico
• Approfondimenti  sull'indagine  HVSR  (ad  esempio  valutazione  del  rispetto  dei  criteri 

SESAME)

La guida è stata creata utilizzando il programma nel sistema operativo Windows XP, ma non ci sono 
particolari differenze per chi lo utilizza in altri sistemi Windows, precedenti e successivi. Inoltre, a 
meno della sezione riguardante l'installazione, la guida è valida anche per gli utilizzatori di Geopsy 
in ambiente Linux.

La  guida  si  concentra  soprattutto  su  aspetti  di  carattere  pratico.  Eventuali 
consigli  su  quali  parametri  adottare  o  su  come  valutare  la  qualità 
dell'elaborazione  derivano  dall'esperienza  e  dalla  conoscenza  personali  degli 
autori  e  sono  da  ritenersi  assolutamente  non  vincolanti.  La  responsabilità 
dell'inserimento  di  dati  e  parametri  e  della  validazione  del  risultato  spetta 
esclusivamente all'operatore.

Benché si sia prestata la massima attenzione nella redazione del documento, gli 
autori non si assumono nessuna responsabilità per eventuali errori o omissioni 
causati dall'aver seguito quanto esposto in questa guida.
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Download
È possibile scaricare il programma di installazione di Geopsy dal sito:

www.geopsy.org

Cliccando  sull'etichetta  Download nella  pagina  sopra  mostrata  si  può  accedere  alla  pagina  di 
download.

SARA electronic instruments srl – Italy

http://www.geopsy.org/


5--------------------     Guida all'uso di GEOPSY

Il  progetto  Geopsy.org consiste  in  una  serie  di  programmi,  o  moduli,  correlati  tra  loro  ma 
indipendenti, dei quali il principale è Geopsy, mentre un altro utile per i nostri scopi è dinver.
Benché dalla  pagina  di  download sia  possibile  scegliere  di  aggiungere  o escludere  moduli  dal  
pacchetto di installazione che si andrà a scaricare, si consiglia per semplicità di selezionare tutti i 
moduli, usando il pulsante Select all.
Dopo aver effettuato la selezione va premuto il pulsante  Download, che causerà l'apertura di una 
pagina simile alla seguente.

A  questo  punto  va  scaricato  il  programma  di  installazione  tramite  l'apposito  link  in  alto 
(geopsypack-53items-win32-2.4.4.exe nella  figura  di  esempio),  ignorando  la  richiesta  di 
autenticazione  che  si  trova  in  fondo  alla  pagina  (non  mostrata  in  figura).  Il  programma  di 
installazione scaricato avrà lo stesso nome utilizzato per il link.
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La prima volta che si effettua il download solitamente viene mostrato un messaggio di errore, prima 
di giungere alla pagina con il link per il download.
Le figure e la modalità di soluzione dell'errore sono relative al browser  Mozilla Firefox. In altri 
browser il procedimento potrebbe essere leggermente differente.

Cliccando sulla scritta Sono consapevole dei rischi la pagina viene espansa.
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Va ora cliccato il pulsante Aggiungi eccezione, che causa l'apertura di un'ulteriore finestra.

Cliccando il pulsante Conferma eccezione di sicurezza, assicurandosi che la casella Salva eccezione 
in modo permanente sia spuntata, sarà possibile accedere alla pagina del download.
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Installazione
Per installare Geopsy va utilizzato il pacchetto di installazione scaricato seguendo le istruzioni del 
paragrafo precedente.
Appena avviato, dopo alcuni secondi in cui del testo scorre su una finestra con sfondo nero, mostra 
la  schermata  di  accettazione  della  licenza  sotto  rappresentata.  Se  viene  mostrato  un  avviso  di 
protezione da parte del sistema operativo si deve passare oltre e confermare l'avvio del programma.

Da questa finestra è possibile leggere le licenze d'uso del programma usando il pulsante View. Per 
accettarle e passare oltre cliccare sull'opzione  I accept the terms of all  these licenses e poi sul 
pulsante Next.

La  finestra  seguente  dà  la  possibilità  di  scegliere  quali  moduli  installare  e  il  percorso  di 
installazione.  Solitamente  non c'è  bisogno di  cambiare  nulla,  per  cui  basta  premere  ancora  sul 
pulsante Next.

Il programma si prepara per l'installazione, mostrando una finestra in cui elenca le azioni eseguite. 
Cliccando il pulsante Install si avvia l'installazione.
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A questo punto il programma esegue l'installazione, al termine della quale la finestra mostrata è 
simile a quella sottostante.

Cliccando sul pulsante Close l'installazione ha termine.

Il programma di installazione non crea nessuna icona sul desktop, ma solo la voce Geopsy.org nel 
menù  dei  programmi.  Per  aggiungere  manualmente  al  desktop  le  icone  di  Geopsy e  dinver,  i  
programmi  di  cui  si  parlerà  nel  corso  della  guida,  basta  cliccare  con  il  tasto  destro  sopra  il  
programma desiderato e selezionare la voce Invia a → Desktop (crea collegamento), come mostrato 
nella figura seguente (l'aspetto grafico può variare a seconda del sistema operativo utilizzato).
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Prima esecuzione e schermata principale
Al primo avvio Geopsy mostra la finestra di impostazione delle opzioni, o preferenze, di utilizzo del 
programma.
L'azione suggerita è cliccare sulla casella Show this dialog on startup in fondo alla finestra, in modo 
da toglierne la spunta, e premere sul pulsante OK, senza modificare nessuna delle opzioni.
Si potrà accedere nuovamente a quella finestra dal menù principale del programma, alla voce File  
→ Preferences.

All'apertura il programma mostra la finestra seguente.

I pulsanti della barra degli strumenti in alto servono per eseguire diversi tipi di elaborazione.
Come già accennato, questa guida affronterà solo l'elaborazione di prove HVSR e MASW.
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Elaborazione prova HVSR
Questa  sezione  spiegherà  come  utilizzare  Geopsy per  l'interpretazione  di  dati  misurati  da  una 
singola stazione con il metodo dei rapporti spettrali o HVSR (Horizontal to Vertical Spectral Ratio). 
Il risultato dell'elaborazione è una curva,  detta di ellitticità,  che rappresenta appunto il rapporto 
spettrale tra il segnale delle componenti orizzontali e quello della componente verticale.
Questa curva permette di valutare in modo diretto le frequenze di risonanza del sito indagato; una 
sezione seguente di  questa  guida mostrerà come utilizzare il  programma dinver  per  ricavare la 
stratigrafia, e quindi una stima delle velocità equivalenti, a partire dalla curva di ellitticità.

Descrizione del metodo HVSR
La tecnica,  in  origine  proposta  da  Nogoshi  e  Igarashi  (1971),  in  seguito  diffusa  da Nakamura 
(1989), consiste nella stima del rapporto fra lo spettro di ampiezza delle componenti orizzontali e 
quello  della  componente verticale  dei  microtremori  sismici  ambientali  registrati  da  una singola 
stazione.

Il calcolo del rapporto H/V segue queste fasi:
1. Registrazione del segnale ambientale nelle 3 componenti.
2. Scomposizione  del  segnale  in  finestre  temporali,  con l'obiettivo  di  isolare  le  parti  della 

registrazione  in  cui  il  segnale  risulta  maggiormente  stazionario  ed  eliminare  i  rumori 
transitori, o transienti.

3. Calcolo e smussamento dello spettro di ampiezza ricavato tramite la trasformata di Fourier 
per ognuna delle finestre selezionate su tutte e tre le componenti.

4. Combinazione, con un'operazione di media, delle due componenti orizzontali per ognuna 
delle finestre selezionate.

5. Calcolo del rapporto H/V per ogni finestra.
6. Calcolo della media dei rapporti H/V delle singole finestre, che rappresenterà la curva H/V 

definitiva.

Come si vedrà,  Geopsy è in grado di assistere attivamente l'utente nella fase di selezione delle 
finestre ed esegue in modo automatico tutti gli altri passaggi, dal 3 al 6, permettendo di ottenere in 
modo semplice e veloce la curva H/V.

Vale la pena di aggiungere una nota breve ma fondamentale. L'apparente semplicità di un'indagine 
HVSR, sia in fase di acquisizione che di elaborazione dei dati, non deve far pensare che sia una  
misura priva di insidie.
L'acquisizione è infatti un'operazione da eseguire con grande accortezza: tanto il posizionamento 
dello strumento che la valutazione consapevole del livello e della natura del rumore ambientale che 
si sta registrando sono molto importanti per la riuscita del sondaggio.
In  fase  di  elaborazione  occorre  invece  grande  attenzione  nella  verifica  della  qualità  e 
dell'affidabilità della curva ottenuta. Ad esempio, il fatto che i criteri SESAME, di cui si parlerà in 
seguito,  siano rispettati  non implica necessariamente che il  risultato sia aderente alla situazione 
reale, né che l'acquisizione sia stata eseguita correttamente. D'altro canto, quando i criteri non sono 
rispettati non si può concludere immediatamente che l'acquisizione o l'elaborazione siano errate, ma 
la  curva  ottenuta  potrebbe semplicemente  stare  ad indicare,  a  titolo esemplificativo,  un terreno 
omogeneo e compatto che non dà luogo a fenomeni di amplificazione. I criteri quindi indicano se la  
curva contiene o meno elementi significativi dal punto di vista geofisico, ma possono dire poco 
sulla sua correttezza e coerenza.
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L'elaborazione HVSR, per non parlare dell'operazione di inversione, richiede assolutamente 
che l'operatore agisca con cognizione di causa, senza affidarsi ciecamente a parametri che 
regolano solo alcuni aspetti dell'indagine, e che utilizzi con criterio eventuali ausili informatici 
che operano in modo automatico.

In questa guida non si parlerà ulteriormente di come effettuare questo tipo di valutazioni, ma si 
rimanda alla letteratura disponibile in materia, in particolare al documento che contiene le linee 
guida ufficiali del progetto SESAME, disponibile attualmente al seguente indirizzo:

http://sesame-fp5.obs.ujf-grenoble.fr/Papers/HV_User_Guidelines.pdf

Scelta delle frequenze di interesse
È utile avere un'idea del range di frequenze utile entro cui si può calcolare l'HVSR.
Se ad esempio la frequenza di campionamento è di 200 Hz, significa che, per il teorema di Nyquist,  
non sarà assolutamente possibile visualizzare frequenze superiori a 200/2 = 100 Hz.
Il limite inferiore che si può raggiungere in frequenza dipende dai sensori utilizzati, dalla qualità 
dell'acquisitore, dalla durata della registrazione e dalla scelta delle finestre. Come regola generale 
(anche se molto empirica) si  può considerare che la frequenza più bassa osservabile (o almeno 
decentemente osservabile) si ha dividendo la durata del campionamento per 10, ad esempio 1200 
secondi/10 = 18 secondi = circa 0,008 Hz, per un'acquisizione di 20 minuti.
Questo  calcolo  è  del  tutto  teorico  in  quanto  presuppone che  venga utilizzata  una  sola  finestra 
comprendente l'intera registrazione. Nella pratica si utilizzano molte finestre più brevi e la minima 
frequenza raggiungibile dipenderà dalla durata di queste finestre: se ad esempio si usano finestre di 
60 secondi si potrà osservare fino a 60/10 = 6 secondi = circa 0,17 Hz.
Rovesciando il ragionamento possiamo dire che se intendessimo esaminare frequenze, ad esempio, 
fino  a  0,05  Hz  non  potremmo  farlo  agevolmente  se  non  abbiamo  almeno 200  secondi  di 
sismogramma. Diciamo “almeno” perché sarebbe meglio avere una registrazione più lunga così da 
avere la possibilità di eliminare porzioni di sismogramma contenenti eventuali disturbi ambientali e 
da poter scegliere più di una finestra temporale.

In  Geopsy,  come si  vedrà  nella  sezione  seguente,  è  possibile  scegliere  le  frequenze  entro  cui 
calcolare  il  rapporto  H/V.  La  minima  frequenza  che  si  può indicare  è  0,01  Hz,  la  massima  è  
virtualmente illimitata.
Se si  inserisce una frequenza massima oltre la frequenza di Nyquist,  il  rapporto H/V oltre tale  
frequenza sarà piatto.
Se si inserisce una frequenza minima inferiore alla frequenza corrispondente a un decimo della 
lunghezza delle finestre temporali utilizzate (0,17 Hz nell'esempio precedente), Geopsy calcolerà lo 
stesso il rapporto H/V al di sotto di tale frequenza ma evidenzierà la zona tratteggiandola di rosso, 
indicando che in quell'area il rapporto non è affidabile.
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Elaborazione HVSR in pratica
La  prima  operazione  da  eseguire  è  caricare  in  Geopsy  il  file  contenente  i  sismogrammi  da 
analizzare. Geopsy può leggere svariati tipi di file, fra i quali SEG2, SEGY, SAF (Sesame), GSE, 
SAC e miniSeed. Il formato più comune per i dati di indagini HVSR è il SAF, che è il formato di  
default del nostro software di acquisizione SEISMOLOG-MT.
Un modo per caricare il file è tramite la voce di menù File → Import signals → File.

Verrà mostrata una finestra di dialogo standard per la selezione di file, tramite cui cercare e poi 
selezionare il file da aprire.
Una volta aperto il file, la finestra principale di Geopsy si presenta come nella figura seguente.
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La finestra Table riporta le componenti del file e le caratteristiche di acquisizione di ogni canale.
La finestra Graphic mostra il segnale nella serie temporale.

Per procedere al calcolo dei rapporti spettrali si può cliccare sull'icona H/V, in alto nella barra degli 
strumenti.

All'avvio dell'elaborazione H/V Geopsy apre un altro grafico del segnale nel dominio del tempo, 
che verrà utilizzato per visualizzare graficamente la selezione delle finestre temporali, e una finestra 
tramite cui effettuare questa selezione e impostare i parametri di calcolo.

La finestra per il calcolo H/V contiene tre sezioni, mostrate nelle figure seguenti.

La sezione Time permette di indicare i criteri per la scelta delle finestre, tra cui la lunghezza minima 
e massima e i parametri di funzionamento dell'algoritmo di anti-triggering per l'identificazione e 
l'esclusione dei transienti.

La sezione Processing contiene i parametri che regolano il calcolo e il lisciamento degli spettri e la 
modalità di combinazione degli spettri orizzontali.

La sezione  Output permette di indicare il range di frequenze d'interesse, da scegliere secondo le 
considerazioni fatte nel paragrafo precedente, e la densità e spaziatura dei punti della curva H/V 
definitiva.
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I parametri mostrati nelle figure non hanno un valore particolare né sono quelli “consigliati”, ma 
sono semplicemente quelli che Geopsy propone inizialmente.

Per  approfondire  il  significato  di  ogni  campo  e  casella  delle  tre  sezioni  si  rimanda  alla 
documentazione online di Geopsy sull'argomento (in inglese), che attualmente si trova all'indirizzo:

http://www.geopsy.org/wiki/index.php/H/V_spectral_ratio

Per  indicare  a  Geopsy  di  selezionare  automaticamente  le  finestre  temporali  su  cui  eseguire 
l'elaborazione, in base ai parametri impostati, basta cliccare sul pulsante Select, nella sezione Time, 
e selezionare la voce Auto dal menù che viene mostrato.

Per procedere a una selezione manuale bisogna invece selezionare la voce  Add e portarsi con il 
mouse sopra la finestra che rappresenta il segnale nel dominio del tempo. Noterete che la forma del 
puntatore cambierà, ad indicare che ora potete selezionare delle finestre.
Cliccando con il tasto sinistro del mouse sopra un sismogramma e trascinando vedrete apparire un 
riquadro verde. Quando è della lunghezza che desiderate rilasciate il tasto del mouse. Se la finestra 
rimane visualizzata allora ha lunghezza sufficiente, ed anzi è possibile che venga scomposta in più 
finestre in base ai parametri, se scompare vuol dire che era di lunghezza inferiore alla lunghezza 
minima indicata nel campo Length della sezione Time.

La figura seguente mostra come appare la finestra con la rappresentazione del segnale durante la  
selezione manuale delle finestre.
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Al termine della selezione, automatica o manuale, dovreste essere in grado di ottenere un grafico 
come il seguente, in cui sono stati scartati i transienti più importanti.

Cliccando sul pulsante  Start della sezione  Time si avvierà l'elaborazione H/V vera e propria, che 
impiegherà più o meno tempo a seconda del numero e della lunghezza delle finestre.

Al termine dell'elaborazione Geopsy mostra il grafico della curva H/V risultante e colora in modo 
diverso ogni finestra temporale selezionata, come nella figura seguente.
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Il grafico della curva H/V si presenta invece come nell'immagine che segue.

La curva nera continua rappresenta il rapporto H/V medio, mentre le curve nere tratteggiate, dette 
“curve di confidenza”, sono il risultato della moltiplicazione (curva superiore) e divisione (curva 
inferiore) dei valori del rapporto H/V medio per la deviazione standard dei valori  delle singole 
curve H/V.
Le curve colorate sono i rapporti H/V delle singole finestre; grazie al colore è possibile associare 
ogni curva alla corrispondente finestra temporale.
Le due bande grigie identificano la frequenza principale,  o  f0,  individuata automaticamente dal 
programma. La f0 del rapporto medio è esattamente al centro delle due bande, mentre l'area coperta 
dalle bande è ottenuta aggiungendo e sottraendo alla f0 del rapporto medio la deviazione standard 
delle f0 delle singole curve.
L'area tratteggiata di rosso indica invece la zona di frequenze in cui il rapporto calcolato non è 
affidabile in quanto le finestre temporali scelte per l'elaborazione non sono lunghe a sufficienza per 
raggiungere quelle basse frequenze.
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Modifica della rappresentazione grafica del rapporto H/V
È  possibile  modificare  alcuni  parametri  della  rappresentazione  grafica,  come  dimensioni  del 
grafico, colori, scala, aspetto e spaziatura della griglia e nascondere o mostrare alcune delle curve.
Per farlo si deve cliccare con il tasto destro sopra il grafico e selezionare la voce  Properties dal 
menù contestuale che viene mostrato, oppure tramite la voce Format → Properties del menù della 
finestra che contiene il grafico.

La finestra che viene mostrata contiene diverse sezioni, accessibili tramite le etichette poste sul lato 
sinistro.

La  sezione  Object,  ad  esempio, 
permette  di  modificare  le 
dimensioni  del  grafico,  grazie  ai 
campi Width(cm) e Height(cm).

Nella  sezione  Graphic invece  è 
possibile mostrare o nascondere gli 
oggetti  grafici  rappresentati 
agendo sulla colonna Opacity della 
tabella  nella  parte  bassa  della 
finestra: se il valore è uguale a 1 il 
relativo  oggetto  è  mostrato,  se 
uguale  a  0  è  nascosto.  Un valore 
intermedio rende gli oggetti più o 
meno trasparenti.

È possibile mostrare o nascondere 
il rapporto H/V medio(Average), le 
curve  di  confidenza  (Stddev),  le 
curve  dei  singoli  rapporti 
(Windows),  le  bande  di 
identificazione  della  frequenza 
principale (f0) e l'area tratteggiata 
che indica le frequenze per cui il 
calcolo non è affidabile (T10).
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Raffinamento del rapporto H/V
Una volta calcolato il  rapporto H/V è possibile modificare la scelta delle finestre temporali  e i 
parametri di calcolo e ripetere l'operazione, in modo da raffinare il risultato ottenuto inizialmente.

È ad esempio utile individuare ed escludere eventuali finestre temporali con disturbi magari non 
individuati dall'algoritmo di anti-triggering ma che danno origine a curve H/V che deviano in modo 
significativo rispetto alla media e che quindi perturbano il risultato definitivo.
Benché sia possibile eseguire questa operazione manualmente, Geopsy offre la possibilità di farlo 
automaticamente in due semplici passaggi.

Per prima cosa va scelta la modalità di esclusione delle finestre temporali, cliccando con il tasto 
destro  sul  grafico  del  rapporto  H/V  e  selezionando  la  voce  Reject  time  windows dal  menù 
contestuale che viene mostrato. A questo punto la forma del puntatore cambierà e, cliccando il tasto 
sinistro e tenendolo premuto, sarà possibile tracciare un riquadro sopra il grafico, come mostra la 
figura seguente.

Al rilascio del pulsante, tutte le curve che sono incluse anche solo in parte all'interno del riquadro e 
le relative finestre temporali nel grafico del segnale del dominio del tempo si coloreranno di grigio.
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A questo punto, cliccando sul pulsante Select, nella sezione Time della finestra per il calcolo H/V, e 
selezionando la voce Remove dal menù che viene mostrato, il puntatore assumerà la stessa forma 
che ha quando si seleziona la voce Add per aggiungere manualmente nuove finestre temporali, ma il 
riquadro che si traccia al di sopra del grafico cliccando il pulsante sinistro del mouse e tenendolo 
premuto  sarà  di  colore  rosso  e  le  finestre  incluse  anche  solo  in  parte  all'interno  del  riquadro 
verranno eliminate.

La figura seguente mostra come appare il grafico del segnale nel dominio del tempo durante la 
selezione delle finestre da rimuovere.

Sono  evidenti  le  finestre  temporali  colorate  di  grigio  dalla  funzione  Reject  time  windows e  il 
riquadro rosso che, al rilascio del mouse, causerà la rimozione delle due finestre incluse al suo 
interno su tutti e tre i canali.

Va fatto notare che non è obbligatorio eliminare tutte le finestre grigie prima di effettuare di nuovo 
il calcolo del rapporto H/V; è inoltre possibile utilizzare la funzione di rimozione delle finestre 
temporali in modo indipendente, senza prima evidenziare di grigio le finestre che si ritiene siano 
causa di disturbi, che in questo caso andranno individuate manualmente.

Una volta raffinata la selezione delle finestre, cliccando di nuovo il pulsante  Start nella sezione 
Time della finestra per il calcolo H/V sarà possibile ricalcolare il rapporto H/V sulle nuove finestre.
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Salvataggio del rapporto H/V
Quando il rapporto H/V è stato calcolato in modo soddisfacente solitamente si desidera esportarne i 
dati in modo da utilizzarli, ad esempio, nel modulo dinver ed effettuarne l'inversione o salvare il 
grafico in formato immagine.

Per salvare il grafico sotto forma di file immagine basta selezionare la voce Edit → Copy image dal 
menù della finestra che contiene il grafico, dopo di che l'immagine, che è stata copiata da Geopsy 
negli appunti di Windows, va incollata nel programma di destinazione desiderato.

Per esportare i dati numerici della curva va invece usata la voce Tools → Save results dello stesso 
menù: verrà mostrata la finestra standard per il salvataggio di file in cui andrà indicato il percorso e 
il nome del file in cui salvare i dati.

All'atto  del  salvataggio  Geopsy crea  due  file,  entrambi  con  il  nome  indicato  nella  finestra  di 
dialogo, ma con diversa estensione: uno ha estensione “.hv”, l'altro “.log”. Entrambi sono semplici 
file di testo leggibili con qualsiasi editor testuale che supporti file con terminatore di riga in stile 
UNIX; in Windows è più che sufficiente il programma WordPad, mentre non è adatto il classico 
Blocco note.
Il file con estensione “.hv” contiene i dati della curva del rapporto H/V medio e delle curve di 
confidenza ed è quello che andrà importato nel modulo dinver.
Il file con estensione “.log” contiene i parametri effettuati per il calcolo e i dati su tutte le finestre 
temporali  selezionate  e  può  essere  usato,  come  si  vedrà  nella  sezione  seguente,  per  replicare 
l'elaborazione in un secondo momento.
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Visualizzazione e calcolo degli spettri delle singole componenti
Un'elaborazione accessoria che può aiutare a verificare la validità del rapporto H/V calcolato è la 
visualizzazione  separata  degli  spettri  di  frequenza  delle  singole  componenti.  In  particolare, 
l'andamento  dello  spettro  della  componente  verticale  in  relazione  a  quello  delle  componenti 
orizzontali permette di avere un'indicazione sulla natura dei picchi evidenziati dal rapporto H/V, se 
di origine naturale o antropica.

Il calcolo degli spettri avviene in modo molto simile a quello del rapporto H/V, in quanto anche esso 
viene effettuato su finestre temporali,  dando origine a uno spettro per ogni finestra, e lo spettro 
definitivo è quello risultante dalla media degli spettri di tutte le finestre.

Per avviare il calcolo, dopo aver caricato il file, si deve cliccare sull'icona Spec, in alto nella barra 
degli strumenti, dopo di che si dovrà procedere alla selezione delle finestre temporali, esattamente 
come nel calcolo del rapporto H/V.

Geopsy rende  molto  semplice  selezionare 
le  stesse  finestre  usate  per  l'elaborazione 
HVSR, se questa è stata già effettuata e i 
risultati sono stati salvati su file.

Per farlo basta selezionare la voce Load dal 
menù  mostrato  cliccando  sul  pulsante 
Select della sezione Time della finestra per 
il calcolo degli spettri, come mostrato nella 
figura a fianco.
Verrà  mostrata  la  finestra  di  dialogo 
standard  per  la  selezione  di  file,  da  cui 
andrà  scelto  il  file  con  estensione  “.log” 
esportato  al  termine  dell'elaborazione 
HVSR.
Geopsy leggerà da questo file il numero e 
la  lunghezza  delle  finestre  utilizzate  in 
precedenza  e  le  selezionerà 
automaticamente  nel  grafico  del  segnale 
utilizzato per il calcolo.
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Premendo il pulsante Start nella sezione Time sarà avviato il calcolo degli spettri, il cui risultato è 
mostrato in due finestre separate rappresentate nelle figure seguenti.

I  tre  grafici  della  finestra  Spectrum  Results rappresentano  i  singoli  spettri,  nella  classica 
visualizzazione con spettro medio, curve di confidenza e uno spettro colorato per ogni finestra.

Il grafico a sinistra nella finestra  Spectrum summary raggruppa gli spettri medi di tutte e tre le 
componenti;  agendo sulla finestra delle proprietà è possibile modificare il  colore delle curve in 
modo da riconoscere a quale componente appartiene ciascuno spettro.
Il grafico a destra rappresenta lo spettro medio complessivo e la sua deviazione standard.
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Valutazione della stazionarietà e della direzionalità del rapporto H/V
Altre  informazioni  che  aiutano  ad  avere  un'idea  della  bontà  dell'indagine  HVSR riguardano  la 
stazionarietà e la direzionalità del rapporto H/V.

Per stazionarietà si intende la stabilità del rapporto H/V lungo tutta la durata dell'indagine: i singoli 
rapporti H/V correlati ciascuno ad una finestra temporale dovrebbero essere più simili possibile, 
specie per quanto riguarda la frequenza a cui si manifesta il  picco,  o i picchi,  di  ampiezza del 
rapporto. In Geopsy non è possibile generare un grafico che riassuma questa informazione, anche se 
si può avere un'idea della stazionarietà del rapporto osservando le curve colorate, che rappresentano 
i singoli rapporti H/V, nel grafico del rapporto H/V definitivo.

La direzionalità del rapporto H/V è invece l'informazione riguardante la direzione di provenienza 
del  segnale  sul  semipiano  orizzontale,  che  può  aiutare  a  rilevare  l'eventuale  situazione  non 
desiderabile in cui si ha la polarizzazione del segnale lungo una certa direttrice.
In Geopsy è possibile ricavare il grafico di direzionalità del rapporto H/V tramite il tool H/V rotate, 
accessibile dall'apposita icona nella consueta barra degli strumenti in alto.

L'elaborazione si svolge in modo praticamente identico a quella per il rapporto H/V semplice o per 
gli spettri delle singole componenti.
Il risultato finale è un grafico simile al seguente, ottenuto dalla produzione di un rapporto H/V per 
ogni 10° di rotazione, che riporta sulle ascisse la frequenza, sulle ordinate la rotazione e in cui il  
colore rappresenta l'ampiezza del rapporto.
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Elaborazione prova MASW (F-K attiva)
Prima di importare il file contenente i dati di campagna, tipicamente in formato SEG2, si deve 
aprire la finestra delle impostazioni del programma, tramite la voce di menù File → Preferences, e 
selezionare la  voce  Set  “Rxxx” as name where xxx is  the receiver  number nel  riquadro  Signal  
names, in basso nella sezione Load.
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Va poi importato il file, nello stesso modo in cui si importa il file per l'elaborazione HVSR. La  
finestra principale di Geopsy apparirà come nella figura seguente.

La finestra Table riporta le componenti del file e le caratteristiche di acquisizione di ogni canale.
La finestra Graphic mostra il segnale nella serie temporale.

Per  inserire  la  geometria,  se  necessario,  va  modificata  la  tabella,  in  particolare,  per  geometrie 
lineari, la colonna  Rec x. Per farlo va prima sbloccata la tabella, togliendo la spunta alla voce di 
menù Edit → Lock table edition.
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A questo punto è possibile modificare manualmente la tabella e impostare le coordinate di ogni 
ricevitore.
Un modo alternativo per farlo è utilizzare la finestra che viene aperta dalla voce di menù Edit → Set  
receivers, anche senza sbloccare la tabella.

Vanno poi  inserite  le  coordinate  del  punto di  battuta,  utilizzando la  voce di  menù  Edit  → Set  
sources, che causa l'apertura di una finestra come la seguente.

Una volta inserita la geometria dello stendimento si può avviare il tool per l'elaborazione della 
MASW, dall'apposita icona nella barra degli strumenti in alto, Linear F-K for active experiments.

Il  tool  Linear  F-K permette  di  includere  o  escludere  parte  dei  dati  secondo  criteri  spaziali  o 
temporali. Si può decidere, ad esempio, di escludere le tracce più vicine al punto di battuta, agendo 
sui  campi  Minimum e  Maximum nella  sezione  Pre-processing,  o  di  considerare  solo  il  primo 
secondo, tramite i campi From e To della sezione Processing.
Nella  sezione  Output si  possono  invece  indicare  i  limiti  della  frequenze  e  delle  velocità  da 
considerare.
All'apertura del tool viene anche visualizzato un grafico delle tracce nel dominio del tempo in cui 
viene evidenziata, per ogni canale, la porzione che verrà sottoposta ad elaborazione, in modo simile 
alla finestratura dell'elaborazione HVSR.

Per  approfondire  il  significato  di  ogni  campo  e  casella  delle  tre  sezioni  si  rimanda  alla 
documentazione online di Geopsy sull'argomento (in inglese), che attualmente si trova all'indirizzo:

http://www.geopsy.org/wiki/index.php/Active_source_experiment (MASW)

Dopo aver terminato la fase di impostazione dei parametri, si può avviare l'elaborazione tramite il 
pulsante Start, nella parte bassa della finestra.
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Il risultato dell'elaborazione MASW è mostrato nella finestra che segue e rappresenta il cosiddetto 
spettro F-K.

A questo punto è possibile effettuare il picking della curva di dispersione, sia in modalità manuale 
che automatica, agendo rispettivamente sulle voci Pick curves e Auto pick curves del menù Tools.
La finestra che segue mostra come si presenta la finestra nel corso del picking manuale.

Cliccando con il mouse sopra il grafico è possibile selezionare i punti che, uniti, andranno a formare 
la curva di dispersione.
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Dopo aver completato il picking è possibile visualizzare in forma tabellare, modificare o eliminare 
le  curve  selezionate  dalla  sezione  Curves del  tool  per  l'elaborazione  MASW,  mostrata 
nell'immagine che segue, in particolare tramite l'utilizzo del pulsante Actions.

Infine, selezionando la voce  Save del menù che viene mostrato cliccando sul pulsante  Actions, è 
possibile salvare su file i dati della curva di dispersione correntemente visualizzata nella tabella.
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Inversione prova HVSR
Tramite  il  modulo  dinver  è  possibile  effettuare  l'inversione  dei  dati  ottenuti  dall'elaborazione 
HVSR, ovvero della cosiddetta “curva di ellitticità”, per ricavare il profilo stratigrafico dell'area 
soggetta ad indagine.

Avvio e caricamento dei dati
All'avvio, dinver mostra una schermata simile alla seguente. Bisogna assicurarsi che sia spuntata la 
casella Surface Wave Inversion, dopo di che va premuto il pulsante OK.

La finestra principale di dinver è rappresentata nella figura sottostante.
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Per caricare i dati della curva di ellitticità calcolata tramite Geopsy va innanzitutto selezionata la  
sezione Targets nel riquadro Runs, in alto a destra, tramite l'apposita etichetta, dopo di che si deve 
spuntare  la  casella  Ellipticity  curve e  cliccare  sul  pulsante  Set a  fianco,  lasciando  invariato  il 
contenuto dei campi Misfit weight e Min. misfit.
Dopo aver cliccato il pulsante  Set, l'area che prima era vuota sulla destra del riquadro  Targets, si 
riempie con i campi e pulsanti necessari per la visualizzazione di un rapporto H/V precedentemente 
calcolato, come mostrato nella figura seguente.

Cliccando sul pulsante Load viene mostrata una finestra di dialogo standard per la selezione di file, 
da cui va scelto il file con estensione “.hv” risultante dall'elaborazione HVSR.

Una volta caricato il file il riquadro Targets appare come nell'immagine seguente.
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Inserimento della stratigrafia
Per inserire la stratigrafia di riferimento va selezionata la sezione Parameters nel riquadro Status, 
in basso, che apparirà inizialmente come nella figura seguente.

È  evidente  la  separazione  dei  parametri  in  4  sezioni,  ognuna  delle  quali  corrisponde  a  una 
caratteristica stratigrafica. Per ogni sezione va aggiunto il numero di strati desiderato, cliccando sul 
corrispondente  pulsante  Add,  e  per  ogni  strato  inserito  vanno specificati  lo  spessore  e  i  valori 
caratteristici, fissi o variabili entro un certo range.

Al termine dell'operazione, che è indubbiamente la più delicata dell'intero procedimento, la finestra 
apparirà come nell'immagine seguente, in cui sono stati inseriti tre strati, compreso il bedrock, con 
caratteristiche casuali.
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Avvio del processo di inversione
Dopo aver inserito la stratigrafia è possibile avviare il processo di inversione automatica, attraverso 
cui dinver calcolerà migliaia di modelli stratigrafici, a partire da quello inserito, cercando quello che 
corrisponde alla curva di ellitticità sintetica che meglio approssima quella sperimentale.

Per avviare l'inversione bisogna utilizzare la voce di menù Runs → Add, indicando così di eseguire 
il processo di inversione sulla stratigrafia appena inserita.

Si deve poi passare alla sezione Runs del riquadro Runs e cliccare sull'angolo in alto a sinistra della 
griglia mostrata, in modo da selezionare la riga appena inserita.

Infine, utilizzando la voce di menù Runs → Start si dà inizio al processo di inversione.
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È possibile vedere l'avanzamento del processo, che dura alcuni secondi, dalla sezione  Status del 
riquadro Status, in basso, che appare come nella figura che segue.
Lo scopo del  processo è  quello  di  cercare il  modello stratigrafico  corrispondente  alla  curva  di 
ellitticità sintetica per cui il misfit, ovvero la differenza con la curva di ellitticità sperimentale, è 
minore.

Il grafico a sinistra rappresenta l'andamento del misfit in funzione del numero di modelli generati. È 
chiaro come man mano che vengono generati nuovi modelli il misfit tende a diminuire.
La tabella a destra mostra diverse informazioni, tra cui il numero di modelli e il miglior misfit  
ottenuto.

L'elaborazione  termina  quando  vengono  generati  tutti  i  modelli  previsti,  ovvero,  facendo 
riferimento alla figura d'esempio, quando nella colonna Valid models della griglia viene visualizzato 
“2550/2550”. A quel punto, utilizzando come indicazione il valore definitivo riportato nella colonna 
Min misfit è possibile visualizzare graficamente il risultato dell'elaborazione.
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Visualizzazione dei risultati
Al termine dell'inversione è possibile visualizzare tutti i  modelli stratigrafici e le corrispondenti  
curve di ellitticità generati nel corso dell'elaborazione.
Ovviamente saranno di reale interesse solo quei due o tre per cui il misfit è minore.

Per  visualizzare le  curve di  ellitticità  sintetiche sovrapposte  a  quella  sperimentale,  in  modo da 
valutare  anche  visivamente  la  bontà  dell'elaborazione,  si  deve  selezionare  la  voce  View  → 
Ellipticity del menù principale.
Verrà visualizzata una finestra in cui inserire un valore di misfit massimo: tutti i modelli per cui il 
misfit  è minore del valore inserito verranno visualizzati.  Solitamente è consigliabile inserire un 
valore appena superiore al minimo misfit ottenuto, riportato nella relativa colonna della tabella del 
riquadro Status.

Nel nostro esempio il misfit minimo è circa 1,43; inserendo un valore di 1,50 vengono selezionati 
due modelli, la cui rappresentazione è mostrata nella figura seguente.

La  rappresentazione  del  grafico  e  della  legenda  può  essere  modificata  a  piacimento,  come  in 
Geopsy, cliccando con il tasto destro sopra l'oggetto e selezionando la voce  Properties dal menù 
contestuale che viene mostrato.
Lo stesso vale per la copia dell'immagine negli appunti di Windows, che si può eseguire tramite la 
voce Edit → Copy image del menù della finestra che contiene il grafico.
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Per visualizzare i profili stratigrafici corrispondenti alle curve con il miglior misfit bisogna invece 
utilizzare la voce View → Ground profiles del menù principale.
Anche in questo caso viene mostrata una finestra in cui inserire un valore di misfit di riferimento. 
La finestra contiene anche il campo Ground profiles: solitamente va inserito il valore “2”, in modo 
da visualizzare sia il grafico delle Vs che quello delle Vp.

Inserendo il valore di 1,50 nel campo Maximum misfit viene visualizzata la finestra seguente.

Anche  in  questa  finestra  la  modifica  dell'aspetto  grafico  e  la  copia  delle  immagini  si  possono 
effettuare come di consueto.

Per ulteriori informazioni sull'uso di dinver si rimanda alla sua documentazione online (parziale, in 
inglese), che attualmente si trova all'indirizzo:

http://www.geopsy.org/wiki/index.php/Dinver
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Inversione prova MASW
L'inversione  della  curva  di  dispersione  ottenuta  dall'elaborazione  MASW si  effettua  seguendo 
praticamente lo stesso procedimento dell'inversione HVSR.
La differenza principale è che il set di dati deve essere caricato spuntando la casella  Dispersion, 
nella sezione  Targets del riquadro  Targets della finestra principale di dinver, come mostrato nella 
figura che segue.
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Inversione congiunta HVSR – MASW
Tramite dinver è anche possibile effettuare l'inversione congiunta di MASW e HVSR, indicando 
che l'algoritmo di ricerca deve tener conto sia della curva di dispersione ricavata da un'indagine 
MASW che della curva di ellitticità ottenuta da un'indagine HVSR.
Per fare questo basta spuntare sia la casella Dispersion che la casella Ellipticity curve nella sezione 
Targets del  riquadro  Targets della  finestra principale  di dinver e caricare entrambi i  set  di  dati 
tramite il rispettivo pulsante Set, come mostrato nelle immagini seguenti, dopo di che l'elaborazione 
si esegue come di consueto, con l'inserimento della stratigrafia e l'avvio dell'inversione.
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I criteri SESAME
Il documento che stabilisce le linee guida per l'esecuzione di indagini HVSR, redatto nell'ambito del 
progetto SESAME, indica una serie di criteri che la curva risultante dall'indagine e l'area circostante 
la frequenza di picco, o f0, dovrebbero soddisfare, noti come criteri SESAME.

Come detto in precedenza, il fatto che i criteri siano soddisfatti non implica necessariamente che 
l'indagine sia stata effettuata correttamente; viceversa, quando i  criteri  non sono soddisfatti  non 
significa che l'indagine sia da scartare a priori.
In  ogni  caso,  la  verifica  del  rispetto  di  questi  criteri  si  rivela  spesso  utile  per  determinare  se 
l'indagine  è  rilevante  dal  punto  di  vista  geofisico  o  se  ci  sia  la  necessità  di  approfondire 
ulteriormente la situazione.

I criteri SESAME, come riportati nel documento ufficiale, sono elencati nel prospetto seguente.

SARA electronic instruments srl – Italy



40--------------------     Guida all'uso di GEOPSY

L'operazione preliminare è la scelta della frequenza alla quale verificare il rispetto dei criteri, che 
sarà identificata come f0: questa è solitamente la frequenza di picco, ovvero la frequenza a cui si 
trova il punto massimo della curva H/V.

I primi tre criteri riguardano l'affidabilità della curva nel suo insieme e la correttezza delle finestre  
temporali scelte per l'elaborazione.

1. Il criterio richiede che in ogni finestra temporale la componente del segnale alla frequenza di 
picco compia almeno 10 cicli. Ad esempio, se la f0 è 0,5 Hz, corrispondente a un periodo di 
2 secondi, le finestre temporali devono essere lunghe almeno 20 secondi; se le finestre sono 
lunghe 30 secondi, si avranno 15 cicli. La formula riportata nei criteri presuppone che tutte 
le finestre siano delle stessa lunghezza; se le finestre sono di lunghezza diversa il criterio 
andrebbe verificato per ogni finestra.

2. Perché il criterio sia rispettato, la somma del numero di cicli di tutte le finestre deve essere  
superiore a 200. La formula riportata nei criteri presuppone che tutte le finestre siano delle 
stessa lunghezza; se le finestre sono di lunghezza diversa va effettuata la somma dei risultati 
dell'operazione f0 * lw effettuata per ogni finestra, in cui lw è la lunghezza in secondi di ogni 
finestra.

3. Secondo questo criterio, la deviazione standard del rapporto H/V nell'intervallo di frequenze 
compreso tra la metà e il doppio di f0 deve essere inferiore a 2 o a 3 in base al valore di f0. 
La deviazione standard si può ricavare dalle curve di confidenza, sapendo che si ottengono 
moltiplicando e dividendo il valore di ampiezza del rapporto H/V proprio per la deviazione 
standard. Per comodità è possibile ricavarla dalla tabella che si ottiene caricando in dinver il 
file  in  formato  “.hv”  prodotto  da  Geopsy  come  risultato  dell'elaborazione  HVSR.  Le 
modalità di caricamento del file sono indicate nei paragrafi precedenti e un esempio di come 
l'informazione viene riportata è visibile nella figura seguente.

Questi primi tre criteri dovrebbero essere tutti rispettati.
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I sei criteri seguenti riguardano invece la chiarezza del picco, sia rispetto alle frequenze circostanti 
la f0 che alla sua stabilità nei rapporti H/V delle singole finestre.

4. Questo criterio indica che, nell'intervallo di frequenze compreso tra la f0 e un quarto di f0 
esista almeno una frequenza per cui il valore di ampiezza del rapporto H/V sia minore della 
metà  dell'ampiezza  alla  frequenza  f0;  ciò  significa  quindi  che  il  picco  deve  essere  ben 
distinto rispetto al resto della curva alle frequenze più basse di f0.

5. Questo criterio è simmetrico rispetto al precedente, richiedendo che sia soddisfatta la stessa 
condizione nell'intervallo di frequenze comprese tra f0 e il suo quadruplo.

6. Secondo questo criterio l'ampiezza del rapporto H/V alla frequenza f0 deve essere maggiore 
di 2.

7. Le curve di confidenza solitamente presentano anch'esse un picco in corrispondenza del 
picco della curva media. Perché questo criterio sia rispettato la frequenza del picco delle 
curve di confidenza deve trovarsi nell'intervallo di frequenze delimitato dalla f0 ± 5%.

8. Il  picco  evidenziato  nella  curva  H/V  media  si  trova  anche  nelle  curve  ricavate 
dall'elaborazione sulle singole finestre temporali, a una frequenza simile a f0. Questo criterio 
richiede  che  la  deviazione  standard  della  frequenza  del  picco  nelle  singole  finestre  si 
mantenga al di sotto di una soglia dipendente da  f0; le soglie sono indicate nell'apposita 
tabella sopra riportata.

9. Quest'ultimo  criterio  richiede  che  la  deviazione  standard  dell'ampiezza  della  curva  H/V 
media del singolo punto alla frequenza f0 si mantenga al di sotto di una soglia dipendente da 
f0; le soglie sono indicate nell'apposita tabella sopra riportata.

Perché il picco sia ritenuto chiaro, almeno cinque di questi sei criteri devono essere soddisfatti.

SARA electronic instruments srl – Italy



42--------------------     Guida all'uso di GEOPSY

Verifica del rispetto dei criteri SESAME con Geopsy
Geopsy non permette di verificare direttamente i criteri SESAME, ma è possibile farlo piuttosto 
facilmente esaminando il contenuto dei file prodotti al termine dell'elaborazione del rapporto H/V, 
ovvero i file di formato “.hv” e “.log” menzionati in precedenza.

Alcuni dei dati richiesti per la verifica dei criteri sono visualizzabili tramite dinver. Come mostrato 
nel paragrafo precedente, caricando un file in formato “.hv” in dinver è possibile visualizzare in 
forma tabellare, per ogni frequenza, il valore del rapporto H/V medio, delle curve di confidenza e 
della deviazione standard. Tramite queste informazioni si può verificare il rispetto dei criteri 3, 4, 5, 
6, 7 e 9.

Per conoscere la deviazione standard della frequenza di picco, necessaria per la verifica del criterio 
8, basta aprire il file “.hv” con un editor di testo. Una della righe di commento iniziali contiene la  
dicitura “#f0 from windows” e i tre valori numerici che seguono rappresentano rispettivamente la f0 
media e questo valore ± la deviazione standard; sapendo questo, la deviazione standard della f0 si 
può ottenere con una semplice operazione di addizione o sottrazione.

I criteri 1 e 2, infine, si possono verificare conoscendo la durata di ogni finestra, contenuta nella 
sezione finale del file “.log”, che inizia con la riga “### Time Windows ###”.
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